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Introduction

Technical Support 

 Thank you for purchasing the 

manufacturing defects for one year from the date of purchase. Our technical support 

group is glad to work with you in answering your questions. If you cannot find the 

solution to your particular application,

technical assistance, please use the ways as following:

Tel: 886-3-5727772 (Mon.

Fax: 886-3-5728898

Email: service@lttcorp.com

Web: www.lttcorp.com

Address: No. 121, Lane 99, Pu

Disclaimer 

 The information provided in this document is believed to be reliable. However, no 

responsibility is assumed for any possible inaccuracies or omissions. Specifications 

are subject to change without 

trademarks of Microsoft. Other trademarks are the property of their respective 

owners. 

LTT reserves the right to make changes without further notice to any products herein 

to improve reliability, function, or design. 

of the application or use of any product or circuit described herein; neither does 

convey any license under its patent rights, nor the rights of others.

Special Symbols 

 

Failure to follow instructions may lead to product damage, or error.

 

Failure to follow instructions may lead to injury by

 

Failure to follow 
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Chapter 1  Safety

1.1  Safety Regulation

 

 

 

The SLC-M+ series uses a CO

product by CDRH (the Center for Devices and Radiological Health)

 

Wavelength : 9.3~10.6µm

Maximum output power : 

Visibility : Invisible

 

When operating the 

with the safety regulations as following:

 

� Do not attempt to modify or disassemble any component of the machine without 

LTT technical support

� Do not open the doors of chassis and 

components

� Connect the machine to a grounded outlet. Verify that the voltage of the outlet 

is correct for the machine.

� Do not disable the interlocks which are on top and front doors.

� Be careful about the path of t

eye or skin injury may result.
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Chapter 1  Safety 

Regulation 

series uses a CO2 Laser as a light source. It is classified as a class

CDRH (the Center for Devices and Radiological Health)

Wavelength : 9.3~10.6µm 

Maximum output power : 17 ~ 100W 

Visibility : Invisible 

When operating the SLC-M+ series, be sure to always comply 

with the safety regulations as following: 

Do not attempt to modify or disassemble any component of the machine without 

technical support. 

Do not open the doors of chassis and access the laser tube or electronic 

components, especially while the machine power is on.

Connect the machine to a grounded outlet. Verify that the voltage of the outlet 

is correct for the machine. 

Do not disable the interlocks which are on top and front doors.

Be careful about the path of the invisible laser beam shown in figure. 

eye or skin injury may result. 

 

Laser as a light source. It is classified as a class-IIIR 

CDRH (the Center for Devices and Radiological Health). 

series, be sure to always comply 

Do not attempt to modify or disassemble any component of the machine without 

access the laser tube or electronic 

, especially while the machine power is on. 

Connect the machine to a grounded outlet. Verify that the voltage of the outlet 

Do not disable the interlocks which are on top and front doors. 

he invisible laser beam shown in figure. Otherwise, 
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� Do not watch the laser beam directly during operation. Bright light caused by 

the lasing process can damage the eye. 

� The side and rear doors are fixed by screws for safety. If you open these doors, 

the SLC-M+ will become a Class 4 laser device. For your safe, please wear 

protective goggles. 

� The laser beam may cause fire. Never leave machine along without other 

operator watching during the laser cutting process. Keep a fire extinguisher near 

the machine at any time. 

� Blowing materials with air flow from nozzle while cutting or engraving can avoid 

fire occurring and also obtain good quality. 

� Verify that materials used in the cutting are proper for lasing. Never cut 

substrates that contain PVC or Teflon. 

� Good efficiency of exhaust system makes you avoid breathing dust, debris or 

poison gas. 

� Please comply with maintenance schedule as chapter 4 to keep SLC-M+ working 

well. 

� Before you execute auto focusing function, please make sure that there will be 

no crashing between motion system and other objects. For safety, it is NOT 

recommended to use auto focusing function on inequality materials. 
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1.2  Name Plate and Warning Labels 

 The labels as following are affixed to the SLC-M+. These labels must never be 

removed. If they are damaged or tampered for any reason, please request for LTT 

immediately to replace them.  

 

1  

2 

 

3 

 

4 

 

 

 

Laser Tools & Technics Cor poration 

 Model No: SLC-M+  Serial No: 20150001 

 Specification: Vi60, 220~240V, 30A 

 Manufacture Date: 2015 .01 

 

 N o .  1 2 1 ,  L a n e  9 9 ,  P U - D I N G  R O AD ,  

 H S I N  C H U  CI TY,  TAI WAN ,  R . O . C .  

 TE L  :  8 8 6 - 3 - 5 7 2 7 7 7 2  

 FAX  :  8 8 6 - 3 - 5 7 2 8 8 9 8  
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5 
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1.3  Safety Protection Device  

 � Interlock 

The laser beam will not be emitted if you open the front door. The LED indicator of “DOOR” on control panel will be off. 

 

  
Front door close 

   
Front door opens 

� Laser Switch 

Laser switch on control panel can shut down the power of laser system immediately, 

and it has no effect on motion system. Compared with interlock, Turning off laser 

switch can save power. When you turn on laser switch, the LED indicator of “LASER” on control panel will be on (it needs to take more than 5 seconds to warm 
up laser tube while you turn it on). 

� ON 

 

� OFF 
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� Emergency Stop Switch 

Pressing the red pushbutton can shut down the main power of system immediately 

when emergency condition occurs. And turning right the red pushbutton can recover 

the power (Before recovering power, please clear the trouble in the machine first). 

� ON 

 

� OFF 
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Chapter 2  Installation 

2.1  Unpack and Locate Machine 

 This section explains how to unpack and locate machine. 

1. Locate the machine and keep the recommended space for 

maintenance. 

Unit: mm  

 

2. Lock the wheels to locate the machine. 
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2.2  Package Contents List 
 This section explains the package contents of the SLC. The package includes the 

following components. Before using the unit, check that all components have been 

included in the package. 

 

 

 

1 Box 5 LaserCAM Driver CD-Rom 

2 Cotton Swab 6 USB Cable Driver CD-Rom 

3 Alcohol Dropper 7 Power Cable 

4 Allen Wrench   

 

7 

6 4 

3 

2 

1 

5 
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2.3  Part Names and Functions 
 This section explains the main part names and functions of the SLC-M+. 

  

  

 

1. Front Door                                                         

This door has interlock sensors for safety. If you open this door, the laser will be not 

emitted. 

 

2. Front Door of chassis 

Mostly opening this door is for maintaining. Do NOT open this door if it’s not 

necessary, especially the machine power is on. 

 

3. Side Door (Left/Right) of chassis 

Mostly opening this door is for maintaining. Do NOT open this door if it’s not 

necessary, especially the machine power is on. 

1 

2 

3 

3 
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4. Exhaust Port  

These two ports can exhaust the smoke which is caused by cutting. These ports have 

to be connected to blower through pipes. 

 

5. Rear Door (Left) of chassis 

Mostly opening this door is for maintaining. Do NOT open this door if it’s not 

necessary, especially the machine power is on. 

 

6. Rear Door (Right) of chassis 

Mostly opening this door is for maintaining. Do NOT open this door if it’s not 

necessary, especially the machine power is on . 

 

7. Air Filter 

These parts can dissipate the heat in the chassis which is caused by laser generator. 

6 

7 

5 
4 
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8. Window Lens 

This part can protect 1st ~3rd mirror against dusts or debris. It should be cleaned this 

lens daily. (See chapter 4) 

9. 4th Mirror 

This part reflects laser beam to carriage. Also, it should be cleaned this lens daily. 

(See chapter 4) 

10. Table  

This part can carry materials for cutting. 

11. Carriage 

This part includes 5th mirror, focal lens, nozzle, and auto focusing set. You can move 

it left, right, forth and back by the keys on control panel. (See section 3.3.1) 

8 

9 

10 

11 
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12. Final Mirror 

This part reflect laser beam to focal lens. Also, it should be cleaned daily. (See 

chapter 4) 

13. Focal Lens 

This part can focus the laser beam on materials for cutiing. Also, it should be cleaned 

this lens daily. (See chapter 4) 

14. Auto Focal System 

This part can adjust focal height automatically by touching material. 

15. Air Assist Adjustment 

This part can adjust air flow which is out of the nozzle. 

16. Nozzle 

This part can provide a air assist to protect focal lens against dust or debris. 

17. Real-time Exhaust 

This part can remove dust immediately 

12 

13 

15 

14 
16 

17 
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18. Emergency Stop 

Please see section 1.3 

19. Power Switch 

This switch can turn on/off the main power of this machine.  

20. Laser Power Switch 

Please see section 1.3This switch can turn on/off the main power of this machine. 

21. Table Suction On 

Press this switch then the air of work table can be sucked. 

22. Table Suction Off 

Press this switch can turn off the air suck. 

23. Run  

Press this switch can start to run the work. 

24. Reset  

Press this switch can reset work. 

25. Lcd Display 

LCD display shows the operating menu and information from system. If you want to 

obtain more detail about operating menu, please see section 3.3.1. 

26. Control Panel  

Control panel can operate machine. If you want to obtain more detail about operating 

18 

24 

23 

22 

21 

20 

19 

25 

26 
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menu, please see section 3.3.1.  

 

  

 

27. Function Switch  

This part provides user to switch the premissions by key switch. 

Normal : Cutting without CCD function. 

CCD : Cutting with CCD function. 

Admin : Administration user with all function and close the interlock function. 

*under the [Admin] permission, the machine will become a Class 4 laser device. For 

your safe, please wear protective goggles. (see section 1.1). 

28. PC Power Switch  

This switch controls the power of the built-in computer, turn on the computer before 

use the machine. 

29. LED Light Switch 

This switch controls the light inside the machine. 

30. CCD Light regulator  

This part control the CCD light, adjust it depending on using demand . 

31. CCD Light Switch   

This switch controls the CCD Light, turn it on before use the CCD function. 

32. USB Port 

This part can provide the USB ports to the built-in computer.  

27 

29 

28 

30 

31 

32 
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33. Air Inlet Port 

This part is the total air inlet for this machine.  

34. Air Filter 

This part filtered water vapor in the air is the total air inlet for this machine.  

35. Oil mist separator 

This part provide extra filtered for water vapor in the air. This part is the total air inlet 

for this machine. 

36. Serials Port 

This part is used for the expansion of I/O module. 

37. RJ-45 Ethernet Port  

SLD-M+ provides built-in computer instead of external computer, it provides 

computer Internet or LAN through this port.  

38. Power Inlet 

This part can provide main power through cable from wall power supply.  

33 

35 

37 

38 

36 

34 



Chapter 2   Installation 

 

2.4  Hardware Installation

 

 

 

 

This section explains the installation steps with other hardware.

1. Check environment

� Power supply

Power supply : 220 VAC

� Environment

Temperature: 15

Relative humidity : 35 ~ 85 %

Other : Avoid to dust, dirt, oil, mist, strong vibration, or sudden temperature changes

 

2. Connect AC power cable

3. Connected

19 

2.4  Hardware Installation 

This section explains the installation steps with other hardware.

1. Check environment 

Power supply 

Power supply : 220 VAC, Single Phase 

Environment 

15 ~ 30 ℃,  
Relative humidity : 35 ~ 85 % 

Other : Avoid to dust, dirt, oil, mist, strong vibration, or sudden temperature changes

2. Connect AC power cable 

onnected the pipes from blower to machine

This section explains the installation steps with other hardware. 

Other : Avoid to dust, dirt, oil, mist, strong vibration, or sudden temperature changes 

 

to machine. 
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4. Connect air tube from filter port to Air Compressor. 

 

5. Connect RJ-45 Ethernet cable to machine. 

It provides the built-in computer Internet or LAN. 
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2.5  Driver Installation 

2.5.1  Install Driver 

` This section explains the installation steps for driver on computer. 

 

1. Put the CD-ROM of installation into CD/DVD drive 

2. Go to the [Printers and Devices] window and select the [Add a 

printer] option 

 

3. Select [Add a local printer], then click the [Next] button 
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4. Select [Use an existing port], then select [USB00*(USB printer 

support)], then click the [Next] button. (* means the port number 

of the USB printer support port number). 

 

5. Select [Have Disk…]. 
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6. Select [Browse…] 

 

7. Please select the .inf install file. 

   Please select the file which named match the machine name to install. 

 

8. Select [Next]. 
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9. You can define the name of machine, after the setting, click [OK]. 

 

 10. Select [Install this driver software antway]. 
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 11. Please select [Do not share this printer]. 

 

12. Click [Next]. 

If you want this machine to be the default printer, then please select [Yes], or please select 

[No]. If there are no other drivers installed on your computer, the SLC-M+ will 

automatically be set as your default printer. 
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 13. Go to [Printer and Devices] page and right click [SLC-M+] then 

select [Properties]. Then click [Version] to confirm the version of 

the driver. 
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2.5.2  Uninstall Driver  

 1 Go to [Devices and Printers] window 

2 Select the Printer you want to delete and then press the [Delete 

this Printer] button. 

 

 

3 Press the [Yes] button. 

 

 

4 After the uninstall process, please select random printer then 

select [Print server properties]. 
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5 Switch to [Drivers] tab and choose the Printer you have just 

deleted. Press [Remove] button. 

 

 

6 Select [Remove driver and driver package], then click [OK]. 

 

 
7 Click [Yes] to confirm the uninstall process. 
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8 click [Delete]. 

  

 
 9 Click [OK] to close the window after remove the driver. 

  

 

 10 Close the [Devices and Printers] window. 

 11 Go to [Computer] > [C:] > [LTT], then remove all files under the 

folder. 
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2.5.3  Change USB Cable to Another Port

 This section explains that the steps when change USB 

 

Once you contact the USB Cable to computer, we strongly suggest that do not 

change it to another USB port. If you must change USB cable to another port, you 

have to also change the printer settings of 

next steps. 

 

1.  Connect the USB cable to another port well with 

2.  Open [Devices and Printers

3.  Right click SLC

30 

2.5.3  Change USB Cable to Another Port 

This section explains that the steps when change USB port.

Once you contact the USB Cable to computer, we strongly suggest that do not 

change it to another USB port. If you must change USB cable to another port, you 

have to also change the printer settings of SLC-M+. If this happens, please follow 

1.  Connect the USB cable to another port well with SLC

Devices and Printers] window 

SLC-M+ and select [Properties] 

port. 

Once you contact the USB Cable to computer, we strongly suggest that do not 

change it to another USB port. If you must change USB cable to another port, you 

. If this happens, please follow 

SLC-M+. 
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4.  Switch to [Ports] label. Switch the [USB00*] which is belong to the new port 

and click [OK]. 

 

5.  Done. 
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2.6  CorelDRAW Setup 

 It is strongly recommended to keep the graphic software’s page size the same with 

driver’s page size before you begin editing files. Here you will learn how to setup your 

page and learn how to keep those settings that you don’t have to setup again next 

time. If you are a autocad user, please see section 2.7. 

Go to [Layout] → [Page Setup] 

 

Modify [Width] and [Height] according to work area (See Appendix 1). Click 

[Save Custom Page] button. 
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Name this paper type. It is recommended to name with the machine type. Then 

click [OK] to save. 

 

Click [OK] to complete the paper size adjustment. 

 

 Next time you can select template style while you create new file. 
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2.7  AutoCad Setup 

 Here you will learn how to setup the page and print setting on AutoCAD. 

1.  Page And Layout Setup 

Open the AutoCAD. Type [limits] on the command line then press [Enter] key. 

 

Then press [Enter] key to set the bottom left corner to [0,0]. 

 

Setting the top right corner according to work area (See Appendix 1). Then 

press [Enter] key. 

 

Turn on the grid by typing [grid] on the command line or turn on directly by 

pressing the [GRID] button which located under the command line. The grid 

shows the page area so that can help user to see boundary. 
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Choose [File] → [Save as]. Then select [Files of type] as [*.dwt]. Set file 
name as machine type and then press [Save] button to save the Template 

style. 

 

Write down some description for the template and set the measurement unit 

system you want. 

 

You can select the template file you created whenever open AutoCAD. Next 

time when you use the same page size, you can use the template file directly 

so that you don’t have to setup the page anymore. 
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2.  Print Setting 

Go to [File] → [Plot]. When the [Plot] window shows, select printer driver 
and click [Properties] button. 

 

Select [Modify Standard Paper Sizes] on the tree-list box. Select the 

option which starts with [LTT…]. Press [Modify] button. 
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Modify [Top], [Down], [Left] and [Right] to zero, press [Next] button to 

continue. 

 

Press [Next] button to continue. 

 

Press [Finish] button to continue. 
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Select [Custom Properties] and click [Custom Properties] button at 

middle. 

 

Modify Laser settings if need. Press [OK] to finish driver setting. 
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Press [OK] to back to print setting. 

 

Select [Save changes to the following file] and press [OK] to continue. 
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You will find the printer option that you just created (*.pc3) on [Name] box. 

Please select the new printer instead of original in the future. 

 

Select [Plot style table] to acad.ctb. Press [Edit] button. 

 

Press [Yes] button to continue. 
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Use [Shift] key to help selecting all colors in [Plot styles] list. Set the 

[Linetype] to [solid] and the [Lineweight] to [0.0000 mm] Press [Save 

& close] button to continue. 

 

 Please follow the settings below. Switch to [Plot Settings] tab. Select the 

[Plot scale] to [1:1]. Select the [Plot area] to [Limits]. The [Drawing 

orientation] should be set to [Landscape]. Then Press [OK] to send file to 

machine. 
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2.8  LTT Product Tools 

2.8.1  Install Procedure 

 LTT Product Tools is the software which can send prn or plt file, update firmware, and 

change the Ethernet settings. This section explains the installation steps on your 

computer. 

1.  Double click [setup.exe], (the file is included in the installation CD) 

 

2.  When you see the diagram below, please press the [Accept] key to go on. If not, 

please go to Step 4. 
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3. When you see the diagram below, please wait for some minutes. 

 

4. When you see the diagram below, please press the [Next] key to go on. 
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5. When you see the diagram below, please choose a position to install the software, 

or use the default value. And press [Next] key to go on. 

 

6.  Press [Next] key to go on. 
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7.  Press [Close] key to finish the setup procedure. 

 

8.  After the setup procedure, you can open the software from two shortcuts. The 

first one locates on the [Desktop], and the second one is placed in the [Start 

Manu]. 
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2.8.2  Uninstall Procedure 

 1.  Click [Start] �[Settings] � [Control Panel] 

 

2.  Double click [Add or Remove Programs] 

 

3.  Click [LTT Product Tools] � Press [Remove] key 
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4.  Please choose [Yes] 

 

5. Done 

 

 

2.9  In-Sight Explorer Installation 

2.9.1  Install Procedure 
 1. Please copy the file [Cognex In-Sight Software 4.7.0.exe] to your PC, and 

double click it. (the file is included in install CD) 

 

2. Click [Next] 
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3. Choose [I accept the terms in the license agreement] and then click [Next] 

 

4. Key in the user name and organization. Then click [Next] 

 

5. Choose Complete and press [Next] 
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6. Click [Install] button to go on. 

 

7. Waiting for install procedure. When seeing blow window. Click [Finish] to finish 

install procedure for In-Sight Explorer. 

 

 8.  After the setup procedure, you can open the software from two shortcuts. The 

first one locates on the [Desktop], and the second one is placed in the [Start 

Manu]. 
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2.9.2  Uninstall Procedure 

 1.  Click [Start] �[Settings] � [Control Panel] 

 

 

2.  Double click [Add or Remove Programs] 

 

 

3. Click [Cognex In-Sight Software 4.7.0] � Press [Remove] key 
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4.  Please choose [Yes] 

 

 

 

2.10  AutoCCD Installation 

2.10.1  Install Procedure 
 AutoCCD is the main control program for cutting with CCD camera. This section 

explains the installation steps to your PC. 

 1. Please find the AutoCCD folder from installation CD. Double click [setup.exe] 

 

 

 2. When you see the diagram below, please press the [Accept] key to go on. If not, 

please go to Step 4. 
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 3. When you see the diagram below, please wait for few minutes. 

 

 

 4. When you see the diagram below, please press the [Next] key to go on. 

 

 

 5. When you see the diagram below, please choose a position to install the software, 

or use the default value. And press [Next] key to go on. 

 

 

 

 

 

AutoCCD  

C:\Program Files\LTTCorp\AutoCCD\ 
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 6.  Press [Next] key to go on. 

 

 

 7.  Press [Close] key to finish the setup procedure. 

 

 

 8.  After the setup procedure, you can open the software from two shortcuts. The 

first one locates on the [Desktop], and the second one is placed in the [Start 

Manu]. 
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2.10.2  Uninstall Procedure 
 1.  Click [Start] �[Settings] � [Control Panel] 

 

 

2.  Double click [Add or Remove Programs] 

 

 

Click [AutoCCD] � Press [Remove] key 
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4.  Please choose [Yes] 
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Chapter 3  Operation 

3.1  Operator Position 

 This section shows the position when you operate machine. 
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3.2  Basic Operation Flow without CCD 
 This section explains the basic and common steps to operate SLC-M+. If you want to 

obtain more detail about operation, please see section 3.3 and 3.4. 

  

Before process the steps in this section, please make sure that you have already 

finished all steps in chapter 2. 

1. Get machine ready. 

Turn on the power. 

Wait for system start and homing process finishing. 

2. Send file to machine. 

Open a drawing file or draw a new one on CorelDraw or AutoCAD. 

Execute the [Print] or [Plot] function. 

Modify the settings of driver. (See section 3.4) 

Click [OK] to send file. 

3. Adjust focal height (if necessary). 

Put the material on the table. 

Move the carriage above the material. 

Press       and select [Yes]. 

4. Execute file. 

Select the file on control panel. 

Make sure all LED indicators on control panel are on. (If not, see chapter 5) 

Press       to start file. 
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3.3  Machine Operation without CCD 
 This section explains the detail about how to operate SLC-M+. 

3.3.1  Control Panel 
  

 

Cursor Up / Increase Values 

Escape 

Cursor Down / Decrease Values 

Enter 

Previous File 

Next File 

Stop 

Run / Pause 

Move to P1 

Move to P2 

Red Beam Switch/ Laser 

Move Carriage Left (X-) 

Move Carriage Right (X+) 

Move Carriage Forward (Y-) 

Move Carriage Back (Y+) 

Homing 

Ready Indicator 

Laser Indicator 

Door Indicator 

Focal Lens Up 

Auto Focusing 

Focal Lens Down 

2 

1 3 

4 

7 

8 

6 

5 

9 

10 

11 

17 

18 

19 

14 

16 

13 

15 

20 

21 

22 

12 
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1. Cursor Up / Increase Values

Move the cursor up or increase values.

2. Escape 

Escape from sub

3. Cursor Down / Decrease

Move the cursor down or decrease values.

4. Enter 

Enter into sub-menu or confirm the selection.

5. Previous 

Select previous file in file list.

6. Next 

Select next file in file list.

7. Stop 

Give up the file that is in pause mode. 

mode. 

8. Run / Pause

Run the file when system is ready or in pause mode. Pause the file when it is running.

9. Move Carriage to P1

Move the carriage to the 

section 3.3.2 

10. Move Carriage to P2

Move carriage to the 

3.3.2 

11. Red Beam 

 

 

Turn on/off the red beam normally. 

But if in the sub-

to emit the laser beam for alignment.

12. Move Carriage Left (X

Move the carriage left slowly when press this key shortly. If you want to move the 

carriage left faster, please press and hold this key.

13. Move Carriage Right (X+)

Move the carriage right slowly when press this key shortly. If you want to move the 

carriage right faster, please press and hold this key.
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1. Cursor Up / Increase Values 

Move the cursor up or increase values. 

sub-menu or sub-selection 

3. Cursor Down / Decrease Values 

Move the cursor down or decrease values. 

menu or confirm the selection. 

 

Select previous file in file list. 

Select next file in file list. 

Give up the file that is in pause mode. You can’t stop file directly which is not in pause 

8. Run / Pause 

Run the file when system is ready or in pause mode. Pause the file when it is running.

9. Move Carriage to P1 

Move the carriage to the location of P1. The way to set location

10. Move Carriage to P2 

Move carriage to the location of P2. The way to set location 

11. Red Beam Switch / Laser 

Turn on/off the red beam normally.  

-menu of [Alignment mode] (See section 

to emit the laser beam for alignment. 

12. Move Carriage Left (X-) 

the carriage left slowly when press this key shortly. If you want to move the 

carriage left faster, please press and hold this key. 

13. Move Carriage Right (X+) 

Move the carriage right slowly when press this key shortly. If you want to move the 

carriage right faster, please press and hold this key. 

You can’t stop file directly which is not in pause 

Run the file when system is ready or in pause mode. Pause the file when it is running. 

location of P1, please see 

 of P2, please see section 

(See section 3.3.2), this key will turn 

the carriage left slowly when press this key shortly. If you want to move the 

Move the carriage right slowly when press this key shortly. If you want to move the 
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14. Move Carriage Forward (Y

Move the carriage forward slowly when press this key shortly. If you want to move 

the carriage forward faster, please press and hold this key.

15. Move Carriage 

Move the carriage back slowly when press this key shortly. If you want to move the 

carriage back faster, please press and hold this key.

16. Homing 

Move the carriage to home and reset the position of home 

position. 

 

After the homing process, you have to press     so that you can leave the homing 

page. 

17. Ready Indicator

This indicator will be on

18. Laser Indicator

This indicator will be on

19. Door Indicator

This indicator will be on

20. Focal Lens Up

Move the focal lens up slowly when press this key shortly. If you want to move the 

focal lens up faster, please press and hold this key.

21. Auto Focusing

Automatically adjust the distance of lens and material to focus length.

22. Focal lens Down

Move the focal lens down slowly when press this key shortly. If you want to move the 

table down faster, please press and hold this key.
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14. Move Carriage Forward (Y-) 

Move the carriage forward slowly when press this key shortly. If you want to move 

the carriage forward faster, please press and hold this key. 

15. Move Carriage Back (Y+) 

Move the carriage back slowly when press this key shortly. If you want to move the 

carriage back faster, please press and hold this key. 

 

Move the carriage to home and reset the position of home 

After the homing process, you have to press     so that you can leave the homing 

17. Ready Indicator 

This indicator will be on when system is ready to run file and no file is in pause mode.

18. Laser Indicator 

This indicator will be on when laser tube is ready for emission.

19. Door Indicator 

This indicator will be on when all doors with interlocks are closed.

20. Focal Lens Up 

Move the focal lens up slowly when press this key shortly. If you want to move the 

faster, please press and hold this key. 

21. Auto Focusing 

Automatically adjust the distance of lens and material to focus length.

22. Focal lens Down 

Move the focal lens down slowly when press this key shortly. If you want to move the 

faster, please press and hold this key. 

Move the carriage forward slowly when press this key shortly. If you want to move 

 

Move the carriage back slowly when press this key shortly. If you want to move the 

Move the carriage to home and reset the position of home if the carriage loses its 

After the homing process, you have to press     so that you can leave the homing 

when system is ready to run file and no file is in pause mode. 

when laser tube is ready for emission. 

when all doors with interlocks are closed. 

Move the focal lens up slowly when press this key shortly. If you want to move the 

Automatically adjust the distance of lens and material to focus length. 

Move the focal lens down slowly when press this key shortly. If you want to move the 
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3.3.2  Operating Menu 

 1. Work Display 

 

1 /11* 

Indicates that there are totally 11 files in memory, and the first file is selected at 

present. You can press     and     to select files. 

PICTURE-2 :  

Indicates that the present file is named “PICTURE-2”. You can name file on the tab 
“Page” of driver. (See section 3.4.3) 

QTY  2/5 :  

Indicates that the file is limited to be executed 5 times at most, and system has 

finished 2 times. It will be invalid to press      if system has finished 5 times. The 

way to modify this setting is described in section 3.4.3. 

COPY 3 : 

Indicates that the file will repeat 3 times automatically if you press     one time. 

The way to modify this setting is described in section 3.4.3. 

Time  0:29 /  0:00 

The first timer records the pass time at present when a file is executed. The second 

timer will record the total time if the file has ever finished at one time 

Free  63.15 MB  dpi 0 

If no file is executed, this line will display available memory. If a file is being 

executed, it will display the current power and speed settings. 

■1. WORK DISPLAY 

2. FILE MANAGER 
3. LASER PARAMETER 
4. SYSTEM SETUP 

1/11*      PICTURE-2 ■QTY   2/5   COPY 3 

Time   0:29 /    0:00 
Free  63.15MB  dpi 0 

■1/11*      PICTURE-2 

QTY   2/5   COPY 3 
Time   0:29 /    0:00 
Free  63.15MB  dpi 0 
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 2. FILE MANAGER 

 

1 /11*    PICTURE-2 

Like the definition in Work display, it indicates the number and name of files. You can 

press     and     to select files. 

Del. the file :  

This selection can delete single file which is selected at present. 

Delete all files : 

This selection can delete all files in memory. 

Net Status 

This selection can show the settings of Ethernet. 

1. WORK DISPLAY ■2. FILE MANAGER 

3. LASER PARAMETER 
4. SYSTEM SETUP 

1/11*      PICTURE-2 ■Del. the file      134B 

Delete all files 
Net Status 

You Sure? ■Yes 

No 
 

You Sure? ■Yes 

No 

 

1/11*      PICTURE-2 
Del. the file      134B ■Delete all files 

Net Status 

■1/11*      PICTURE-2 

Del. the file      134B 
Delete all files 
Net Status 

1/11*      PICTURE-2 
Del. the file      134B 
Delete all files ■Net Status 

Computer Name/Shared 
=LTTWORK/TMP 
Local Machine ID 
=LAS4B-0001 
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 3. Laser Parameter 

 

1. WORK DISPLAY 
2. FILE MANAGER ■3. LASER PARAMETER 

4. SYSTEM SETUP 

Color setup ■Color control 

Laser tickle setup 
Alignment mode 

Color Control 
by file 
 
 

Laser tickle setup ■Rate           5 khz 

Idle width             1 usec 
Live width         1 usec 

Color setup 
Color control ■Laser tickle setup 

Alignment mode 

■Color setup 

Color control 
Laser tickle setup 
Alignment mode 

Color setup 
Color control 
Laser tickle setup ■Alignment mode 

■Setting Pen    1 Blac 

Power          50% 
Speed         100% 
PPI            1000 

Alignment mode ■Tickle output      1% 

Continuous        off 
Fast move         off 
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Color Setup 

     The settings of

been sent. It is not necessary

driver before sending

Setting Pen 

Indicates the color you want to modify.

Power 

     Indicates the present power for setting pen. Its range is between 0~100%.

Speed 

     Indicates the present speed for setting pen. Its range is between 0~100%.

PPI 

     Indicates the number of 

they are 166, 200, 250, 333, 500, and 1000.

Color Control 

There are two options: 

settings are defined based on print driver 

color settings are defined based on 

 

Laser Tickle Setup

The laser tickle pre

laser threshold. Increasing tickle width beyond 1 µs

plasma to cause laser emission. By applying a laser tickle, the laser will respond 

predictably to laser signal even when there is considerable “off” time between 

applied pulses. It is recommended

a LTT technician.

 

Alignment Mode

This function is used for alignment of laser. 

function unless instructed to by a LTT technician.

Tickle output 

     Indicates the power 

Continuous 

If this function is on and press     , the laser tickle will emit continuously until 

pressing     again. If this function is off, the laser tickle emits only when you keep 

pressing     . 

Fast move 

     If this function is on, you can move the carriage faster to nine position of 

working table by using motion control keys.
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settings of each color can be adjusted under this selection after the file has 

not necessary to use because mostly all settings

sending the file. 

Indicates the color you want to modify. 

Indicates the present power for setting pen. Its range is between 0~100%.

Indicates the present speed for setting pen. Its range is between 0~100%.

Indicates the number of pulses per inch for setting pen. It has six options, and 

they are 166, 200, 250, 333, 500, and 1000. 

 

There are two options: [by file] and [by panel]. [by file]

settings are defined based on print driver for single file. [by panel]

color settings are defined based on [Color Setup] for all files.

Laser Tickle Setup 

The laser tickle pre-ionizes the gas into a plasma state so that it is just below the 

laser threshold. Increasing tickle width beyond 1 µs will add enough energy to the 

plasma to cause laser emission. By applying a laser tickle, the laser will respond 

predictably to laser signal even when there is considerable “off” time between 

It is recommended NOT to change the settings unless instructed to by 

a LTT technician. 

Alignment Mode 

This function is used for alignment of laser. It is recommended

function unless instructed to by a LTT technician. 

 

Indicates the power for laser tickle. Its range is between 0~100%.

If this function is on and press     , the laser tickle will emit continuously until 

pressing     again. If this function is off, the laser tickle emits only when you keep 

If this function is on, you can move the carriage faster to nine position of 

working table by using motion control keys. 

selection after the file has 

settings are defined in print 

Indicates the present power for setting pen. Its range is between 0~100%. 

Indicates the present speed for setting pen. Its range is between 0~100%. 

pulses per inch for setting pen. It has six options, and 

[by file] means that the color 

[by panel] means that the 

files. 

ionizes the gas into a plasma state so that it is just below the 

will add enough energy to the 

plasma to cause laser emission. By applying a laser tickle, the laser will respond 

predictably to laser signal even when there is considerable “off” time between 

to change the settings unless instructed to by 

It is recommended NOT to use this 

for laser tickle. Its range is between 0~100%. 

If this function is on and press     , the laser tickle will emit continuously until 

pressing     again. If this function is off, the laser tickle emits only when you keep 

If this function is on, you can move the carriage faster to nine position of 
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 4. System Setup 

 

1. WORK DISPLAY 
2. FILE MANAGER 
3. LASER PARAMETER ■4. SYSTEM SETUP 

Configuration ■Position setup 

Status 
About SLC-M-C60M ■Adjust X-Y axis 

Focus Length 
Auto Focusing 
X-Y homing 

■Configuration 

Position setup 
Status 
About SLC-M-C60M ■Rule unit:        step 

Sleep mode:   10 min 
Auto run:          off 
Arc comp:         off 

X loc.     600.000mm 
  Y loc.     500.000mm ■Set as P1 

Set as P2 

Adjust X-Y axis ■Focus Length 

Auto Focusing 
X-Y homing 

Adjust X-Y axis 
Focus Length ■Auto Focusing 

X-Y homing 

Focus = 1.500 inch 
 
 
 

You Sure? ■Yes 

No 

 

You Sure? ■Yes 

No 

 

Adjust X-Y axis 
Focus Length 
Auto Focusing ■X-Y homing 
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Configuration 

Rule unit 

This function can allow user to select the unit of length for system. There are three 

options: step, millimeter, and inch. 

Sleep mode 

After the setting time, system will turn off the power of laser tube if there is still no 

file being executed. 

Auto run 

     This item has been deactivated. 

Arc comp 

          Compensates laser output power while cutting an arc. 

Position setup 

Adjust X-Y axis 

     This function can allow user to set the position of [P1] and [P2]. Please move 

the carriage to the position that you want set for [P1] or [P2]. Then press [Enter] 

when the cursor is on the right side of [Set as P1] or [Set as P2]. 

Focus Length 

This function can change focal length for auto focusing if you change the size of focus 

lens. 

Auto Focusing 

     Focusing the laser automatically. This function is the same with      . 

X-Y homing 

Move the carriage to home, and reset the position of home if the carriage loses 

position. This function is the same with      . 

■X loc.     600.000mm 

  Y loc.     500.000mm 
Z loc.       0.000mm 
data is OK! 
 

Configuration 
Position setup ■Status 

About SLC-M-C60M 

Configuration 
Position setup 
Status ■About SLC-M-C60M 

Laser Tools & 
Technics Corp. 
SN:9810000 

2008/12/5 Ver 8.08 
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Status 

This function can show the position of carriage and table. 

About SLC-M+ #### 

     This function can show the firmware version and the machine serial number. 
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3.4  Print Driver Operation 

 Because SLC-M+ is controlled by a standard Windows printer driver, you can create 

the drawing on your favorite graphics software based on Windows system. When you 

want to send files to SLC-M+, you can easy modify the driver settings just like using 

a desktop printer. There are four tabs in SLC-M+ driver programming: Laser, Job, 

Page, and Power scale.               

3.4.1  Laser Tab 
 The [Laser] tab contains Power, Speed, and PPI for eight colors. Other functions 

enable user to save and load configuration files of driver settings, check driver 

information, tune machine, and customize the language of driver. 

 

  Color 

SLC-M+ system can cut with eight groups of power, speed and PPI according to the 

color in drawing. If the color in drawing does not belong any one of these eight colors, then 

driver will choose a similar one according to its RGB values. 

 Power 

This item can control the output power by setting the percentage of maximum power. 

For example, if the maximum power of Laser generator is 30 Watts, then setting 50% 

power will generate about 15 Watts of output power. 
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 Speed 

This item can control the output speed by setting the percentage of maximum 

speed. For example, if the maximum speed of cutting is 60 ips, then setting 50% 

speed will produce about 30 ips of cutting speed. 

 PPI 

PPI means “Pulses Per Inch”. This item controls the numbers of laser pulses in one 

inch. This item only affects vector cutting. It is recommended to decrease PPI for dull 

materials like wood and increased for polished materials like acrylic. 

 Setup 

The settings of power, speed, and PPI can be modified by editing the text boxes and 

dragging the sliders. Then please click the setup button to save the new values for 

each setting. 

 Save 

Clicking this button will pop up a [Save Setup File] window. User can save all 

settings into a configuration file (*.lcf). 

 

 Load 

Clicking this button will pop up a [Load Setup File] window. User can load all 

settings from a configuration file (*.lcf). 



Chapter 3   Operation 

 70 

 

8. Version 

Clicking this button will show the version of driver. 

9. Advanced. 

Clicking this button will pop up a [Advanced] window. Enter the Password [ltt] and 

press OK, and user can set the Shape Adjustment from 9500 to 10500. This 

parameter allows the file to be enlarged or reduced the size between 95% and 105%. 

(Left bottom is the reference point, and the graphic’s position and size will both be 

changed) 
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3.4.2  Job Tab 
 The Job tab is divided into four sections: Job Mode and Cut & Engrave Setup. 

 

1.  Job Mode 

     Normal 

This mode uses the eight color settings to vector cut graphics drawn in the graphic 

software. (other mode is not applicable for SLC-M+ at this time) 

Advanced Mode 

     Mirror 

This mode will mirror the drawing horizontally. However, we suggest mirroring your 

drawing in the graphics program which will allow you to accurately preview the 

drawing before the job is sent to the machine. 

     Pulse Mode 

     This mode can be enabled for drilling holes. For details on holes drilling, contact 

technical support. 

     Vector Optimization 

This mode can modify the working path base on positions of vector in the drawing, it 

can decrease working time. 

Joint Curves 

This mode can make cutting circle or arc faster and smoother. 
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4
:7

 

Resolution 

(This function is for Engrave, not applicable for SLC-M+) 

Engrave type 

(This function is for Engrave, not applicable for SLC-M+) 

Cut & Engrave Setup 

The Cut & Engrave Setup section allows the user to enable and disable certain 

functions of the machine. If the box next to Cut is unchecked the machine will 

disregard any potions of the graphics that instruct the laser to vector cut. Engraving 

mode is not supply at this time. For more precise control the boxes below each color 

allow the user to disable the cut options independently for each color. 

     By Color 

When [By Color] is selected vector are cut according to the predefined color order. 

And vectors of the same color are cut in the sequence they have been drawn. 

     By Drawing 

When [By Drawing] is selected all vectors are cut in the sequence in which they 

have been drawn, regardless of color. 
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3.4.3  Page Tab 
 The Page Tab is divided into four sections: Page Setup, Job Title, Repetition, 

and Position Mode. 

 

1.  Page Setup 

The Page Setup section includes the Width and Height information of machine.  

2.  Job Title 

The Job Title input box allows the user to input a title for the job being sent to the 

machine. The title entered will be the top line of the job file on the display of the 

machine. 

3.  Repetition 

The Repetition section allows the user to modify the setting of [Copy] and 

[Quantity] which will be shown on panel. (See section 3.2.2) 

4.  Material 

(This function is not support for SLC-M+) 
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5.  Position Mode 

      Temp Ref. Point 

     If this box is checked, the file will not execute in the position as application 

software. Otherwise, it will execute in the position where user determine on 

machine. 

Relative Point 

There are nine relative points. They are Top Left, Top Middle, Top Right, 

Middle Left, Center, Middle Right, Bottom Left, Bottom Middle and Bottom 

Right. Those points mean different positions on the boundary of drawing in 

application software. 

 

Relative Point 

There are nine relative points. They are Top Left, Top Middle, Top Right, 

Middle Left, Center, Middle Right, Bottom Left, Bottom Middle and Bottom 

Right. Those points mean different positions on the boundary of drawing in 

application software. 

 

     Stay Reference Point 

If you want to stay on reference point after job finished, 

you can choose this option. This option can save your 

time when you want to use. 

 

 

 

 

Top Left 

Top Middle 

Top Right 

Middle Left 

Center 

Middle Right 

Bottom Left 

Bottom Middle 

Bottom Right 

Pattern 

Boundary Box 
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3.4.4  Power Scale 
 The Power Scale tab is divided into two sections, Power Scale and Custom Power 

Scale. 

 (This function is for Engrave, not support for SLC-M+) 
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3.5  LTT Product Tools Operation 

3.5.1  File Transfer 
 You can send a output file (*.plt file or *.prn file) from drawing software (CAD or 

Corel Draw) to the machine through this software. And don’t need to open any the 

drawing software. It is suitable for stable mass production. 

*Note : LTT Product Tools provides only file transfer, it can’t change any parameter of 

the drawing (speed, power, ect…). 

Make a [*.plt] or [*.prn] file 

Select [Print/ Plot to file] function after all parameters setting, select [Print] then you 

will get a [*.plt] or [*.prn] file 
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Open the [LTT Product Tools] and select your machine. 

 

Click […] and find your file then click [Send] 

 

You will hear one long beep two short beeps showing that the file transfer has 

completed successfully. 

 

3.5.2  System Upgrade 
 Generally, the file for upgrade will be provided from LTT. The file type is [*.ice]. 

While upgrade is processing and the power is turned off or the cable is disconnected, 

the SLC-M+ may not be upgraded for the moment. If this situation happens, please 

contact LTT. 

 1.  Turn off the SLC-M+, and check that the SLC-M is connected with PC through USB 

cable. 

 2.  Turn on the SLC-M+ and computer. Press and hold     on the control panel right 

after turning on SLC-M+ until the following screen appears. 

 

 

ILS-IIIa 
firmware  upgrade 

V 3.01 
READY !!! 
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 3.  Run [LTT Product Tools], and select the printer. 

 

 

 4.  Then select the [*.ice] file with […] key, then press [Send] key to upgrade the 

firmware of SLC-M+. 

 

 5.  You will hear two short beeps along with the following display, showing that the 

upgrade has completed successfully. 

 

 

 6.  Press     on the Control Panel and you will hear a beep after which SLC-M 

returns to main menu. 

 7.  Check the firmware version in the 4th line of the [ABOUT] submenu (See section 

3.3.2). 

 
firmware  upgrade 

complete  ! 
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3.6  Basic Operation Flow with CCD 

3.6.1  Calibration flow 
 This section explains the calibration steps before operate SLC-M+ with CCD. If you 

want to obtain more detail about operation, please see section 3.7 and 3.8. 

Before executing the steps in this section, please make sure that you have already 

finished all steps in chapter 2. 

 1. Get machine ready. 

 Turn on the power. 

Wait for system start and homing process finishing. 

 2. Link computers, connectivity and language settings 

 Check the connection between PC and machine 

Turn on the PC 

Execute AutoCCD.exe 

Go to [communication setting] and type the password [ltt]. 

Select the language : English, Traditional Chinese, Simplified Chinese, Korean. 

Select RS232 connect port. 

Select the laser machine type. 

  

 3. Adjust focal height of laser focus lens (if necessary) 

 Put the material on the table. 

Move the carriage above the material. 

Press     and select [Yes]. 

 4. Adjust the right focus of the CCD(if necessary) 

 Move the CCD to see any pattern 

Adjust the working distance until image in CCD monitor is clear. 

 5. Preparation steps for CCD calibration.  



Chapter 3   Operation 

 80 

 Put a A4 paper at the center of the working area. Make sure the paper will not be 

moved during the whole calibration. 

Turn on the laser power key. 

Press the Connect button and let the AutoCCD connects with CCD. 

Please DO NOT select the [online] function to avoid the error while calibration. 

 

Go to AutoCCD / File / Open Job. Open [Calibration_Circle_200.job] 

Go to AutoCCD / CCD Setting tab. Key in the Password with [LTT] 

    

 6. Do the [Pixel to MM] calibration. 

 Press [Pixel to MM] button. 

The AutoCCD will automatically send a P2MM.prn file to the machine and then 

marks two circle on the A4 paper. 

AutoCCD will automatically move the CCD to get the image, then calculate the pixel 

to millimeter transform constant. 

Finally you will see the number of [1 Pixel=  mm] will be updated by AutoCCD. 

You can do it again. Please don’t move the marked paper, and turn the laser power 

key off. Then press [Pixel to MM] button again. It will do the above processes all 

over again. 

 

 

 7. Do the [Auto Calibration] calibration. 
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 Press [Auto calibration] button. 

The SLC-M+ will automatically send a Shift.prn file to the machine and then marks 

a circle on the A4 paper. 

AutoCCD will automatically move the CCD and get the image, then calculate the shift 

parameters constant. 

Finally you will see the number of [CCD Shift] will be updated by AutoCCD. 

You can do it again. Please don’t move the marked paper, and turn the laser power 

key off. Then press [Auto calibration] button again. It will do the above processes 

all over again. 

 

 

3.6.2  Operation Flow with CCD  
 This section explains the basic and common steps to operate SLC-M+ with CCD. If 

you want to obtain more detail about operation, please see section 3.7 and 3.8. 

Before executing the steps in this section, please make sure that you have already 

finished all steps in chapter 2. 

1. Get machine ready. 

Turn on the power. 

Wait for system start and homing process finishing. 

2. Get PC ready 

Check the connection between PC and machine 

Turn on the PC 

Execute AutoCCD.exe 

3. Adjust focal height (if necessary) 

Put the material on the table. 

Move the carriage above the material. 

Press     and select [Yes]. 

4. Adjust the right focus of the CCD(if necessary) 

Move the CCD to see any pattern 

Adjust the working distance until image in CCD monitor is clear. 

5. Setting drawing parameter in AutoCCD  

Go to AutoCCD / CCD Setting tab 

Select the [Calibration] mode. 

Go to AutoCCD / CCD Task Control tab 

Load drawing file 

Setup Mark distance 

Setup two point setting 
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Setup start point 

Setup Matrix (if necessary) 

6. Start AutoCCD procedure 

Select printer 

Click       to start CCD task 

 

 

 

 

3.7  AutoCCD Operation 
 AutoCCD is the main control program for cutting with CCD. It is to find reference 

marks of work piece, then re-calculate offset and rotation of the drawing to fit the 

new location of work piece. 

This section explains functions of AutoCCD and how to use them. 

  

3.7.1 Controls 
 

  

1. Address: The CCD IP address. You need to enter the password in [CCD Setting] 

���� [CCD and Control Setting] to change it.(See section 3.7.1.1 for more detail) 

1 

2 

3 

4 
5 
6 

7 8 

9 10 

11 
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2.User & Password: User name and password for CCD control account. You need to 

enter the password in [CCD Setting] ���� [CCD and Control 

Setting] to change it. 

User name can use <admin> or <operator>.  

The default password is empty. If you need to use 

password to control, you have to use In-sight 

Explorer, go to Sensor/User List to modify the 

settings. 

Generally use <operator> can get a easy view of job. 

For <admin> user, you can use <open job> and 

<save job as> in the File tab. 

For <operator> user, you can only use <open job>. 

 

3. Show Sheet: For <admin> user, it will turn on or off the sheet in CCD 

monitor. For <operator> user, it will turn on or off the customer view in 

CCD monitor. 

4. Show Image: Show the CCD Image in CCD monitor. 

5. Online: Make the CCD function working. You can see the real time result of pattern 

position and image in CCD. 

6. Live: See the real time image from CCD. 

7. Zoom in: Zoom in the CCD image in CCD monitor. 

8. Zoom out: Zoom out the CCD image in CCD monitor. 

9. Connect: Connect to the CCD device. Before connection, please check the setting 

of CCD IP address and user account.  

10. Zoom to fit: Zoom in/out the image to fit the vision zone of the CCD Monitor. 

 11.Current Job: Press this button to show what current job is loaded in the CCD. 
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3.7.1.1 Find the CCD IP address 

 When connecting to CCD, CCD device will use DHCP to get an IP address. When CCD 

connection is all right, In-sight Explorer will show the device in [In-Sight 

Network]. You can press [Ctrl]+[Shift]+[1] to show [In-Sight Network] 

window. 

If you still can not find a CCD device, then you can go to [System / Add 

Sensor/Device To Network], press the [Refresh] to search the CCD. 

  

 

 

2. When CCD device is connected. Chick [Help]->[About In-Sight Explorer] to 

see the IP address of CCD device. 
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3.7.1.2 Setup CCD IP address 

 Open In-Sight Explorer, go to Sensor / Network settings. It will open a Network 

Settings window. 

You can change the IP address of the CCD device. 
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3.7.2 CCD Monitor 
 This area can show the image from CCD on time or last time. You can fine tune the 

job loaded in the CCD. For example, you can train a pattern here. (See 3.8 for more 

detail) 
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3.7.3 CCD Task Control 

3.7.3.1 Function description 

 This area is the main settings to control CCD movement to fit the working piece 

marks in the working table. 

 

1.File location: load the drawing file. (See 3.7.3.2 for more detail) 

2.Printer: Select the working machine printer driver like SLC-M+. 

3.Recipe File : The recipe which loaded by the prmissions [admin] of all setting 

include the parameters and drawing selection. 

4.Mark Distance: The distance between reference mark and working picture. (See 

3.7.3.2 for more detail) 

5.Two Point Setting: The distance between two reference marks.(See 3.7.3.2 for 

more detail) 

6.Start Point: The position to search the first reference mark. You can use functions 

of [Position Test] to find it. 

7.Task Count: Count the work-piece and limit the total work-pieces. (The counter 

only count a successful job) 

8.Matrix: For a matrix marks calibration, here are parameters for matrix marks 

settings. 

9.Calibration: Select calibration functions: Two Points, Three Points, One Point 

Matrix, Two Point Matrix. 

1 
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 10.Other Settings:  

Two Pattern : Select this potion if your work piece has two  

deferent mark patterns. 

Allow Retry : This function is only applicable under the matrix calibrations.  Select 

this function, if AUTOCCD calibration is fail in anywhere, then the soft will let the 

machine do the calibration by times you set under the function, then upon the times, 

the machine will let the piece bypass and continual the work. 

Degree : This function is only applicable under One Point Matrix calibration. The 

calibration will fit the rotation angle. 

 11.Start: Start the procedure of CCD function and working. 

 12.View Task History: It can show the task history in txt or excel format. Different 

format can be selected at [Setting]. 

13.File 

Open Job: After connect with CCD, you can open a job saved in the CCD. 

Save Job As: For <admin> user, you can save job in the CCD. 

Load Recipe: Load work recipe for different application. 

Save Recipe As: Save work recipe as a *.rcp file. 

 

 14.Setting: You can key in the password [ltt] to change the task history stored 

format. 

       

 15.Help: It is the version tab. 
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3.7.3.2 Setting Definition 

 File: 

 Drawing file is only contained drawing for cutting. Any other reference drawing will 

make wrong cutting position. Drawing file should be the format in plt or prn. When 

print, please select [Print to file] to save the prn or plt file in your computer. Please 

pay attention before printing, in the driver [Page] tab, the [Position Mode] must leave 

empty checks in [Temporary ref. Point] and [Stay Reference Point] 

 

 Mark Distance: 

 Mark Distance means the distance between reference mark and the top left of the 

drawing. If the top left of the drawing is a curve, the distance is showed below. The 

values of dX and dY are minus in below drawing. 
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For example, the values of dX and 

 Tow Point Setting:

 Two Point Setting is the distance between two reference marks. If the top left one is 

the origin of the coordinates, the coordinate of the bottom right one is the setting.

For example, two point setting of above picture is dX= 6 , dY= 4

 Matrix: 

 In the following example, each cell has two cross at top

Number for x, y are 4, 3.

Distance for x, y are 85, 70.

 

 

90 

For example, the values of dX and dY in below drawing are 

 

Tow Point Setting: 

Two Point Setting is the distance between two reference marks. If the top left one is 

the origin of the coordinates, the coordinate of the bottom right one is the setting.

 

example, two point setting of above picture is dX= 6 , dY= 4

In the following example, each cell has two cross at top-left and down

Number for x, y are 4, 3. 

Distance for x, y are 85, 70. 

dY in below drawing are -6 and -6 

Two Point Setting is the distance between two reference marks. If the top left one is 

the origin of the coordinates, the coordinate of the bottom right one is the setting. 

example, two point setting of above picture is dX= 6 , dY= 4 

left and down-right. 
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 Parts Selection: 

 Under this function, you can choose the pieces you want to do or by 

pass. 

 

 

 One Point Matrix: 

 Under this function, AUTOCCD will take only one point for calibration 

for every piece.  

With its sub-function [Input Angel], then enter the angel in [Degree] to 

specifies the default rotation angle. 

With its sub-function [Allow Retry] to retry calibration or bypass the fail piece. 

Under the calibrate function, you will get the shorter working time. 
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 Two Points Matrix: 

 Under this function, AUTOCCD will take two points for calibration for 

every piece. 

With its sub-function [Calibrate One Cut One], will let machine cut one 

piece after done one calibrate, till all pieces are done. 

With its sub-function [Allow Retry] to retry calibration or bypass the 

failed piece. 

Under this calibrate function, you will get a better calibrate/cutting 

quality. 

 

 

3.7.4 CCD Setting 
 Here are the functions for user to calibration, setup for CCD job, setup Start point. 

 

CCD shift: The CCD shift is the distance between laser focus and the center of CCD 

camera. (See 3.7.4.1 for more detail) 

Auto Calibration: Do auto calibration to update CCD shift values. 

3. CCD Field Of View: It shows the field size of CCD View in mm. (See 3.7.4.1 for more 

detail) 

4. Pixel to MM: Do auto calibration to update 1 Pixel to mm transform constant. 

5. CCD and Control Setting: Before change the CCD IP address, user, CCD shift and CCD 

Field of View, you need to enter the password. When enter the password, you need to 

click [OK] to make it work. After change those settings, you can click [Disable] to 

prevent any other one from changing settings. 
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6. Position Test: You can move the carriage by using this function. You can find the start 

position by using this function too. (See 3.7.4.2 for more detail) 

3.7.4.1 CCD shift and CCD Field Of View 

 This section will show you how to do the auto calibration of CCD Shift and CCD Field Of 

View. It is very important for SLC-M+ cutting with CCD. It is a very basic setting for CCD. 

If the number of CCD Shift and CCD Field Of View are not right, you can not get a accuracy 

cutting with CCD. 

Please do the [Pixel to MM] first and then [Auto Calibration] 

1. Preparation steps for CCD calibration.  

Put a A4 paper at the center of the working area. Make sure the paper will not be moved 

during the whole calibration. 

Turn on the laser power key. 

Press the Connection button and let the AutoCCD connects with CCD. 

Please DO NOT select the [online] function to avoid the error while calibration. 

 

Go to AutoCCD / File / Open Job. Open [Calibration_Circle_200.job] 

Go to AutoCCD / CCD Setting tab. Key in the Password with [LTT]. 

2. Do the [Pixel to MM] calibration. 

Press [Pixel to MM] button. 

The AutoCCD will automatically send a P2MM.prn file to the machine and then marks two 

circle on the A4 paper. 

AutoCCD will automatically move the CCD to get the image, then calculate the pixel to 

millimeter transform constant. 

Finally you will see the number of [1 Pixel=  mm] will be updated by AutoCCD. 

You can do it again. Please don’t move the marked paper, and turn the laser power key off. 

Then press [Pixel to MM] button again. It will do the above processes all over again. 
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3. Do the [Auto Calibration] calibration. 

Press [Auto calibration] button. 

The SLC-M+ will automatically send a Shift.prn file to the machine and then marks a circle 

on the A4 paper. 

AutoCCD will automatically move the CCD and get the image, then calculate the shift 

parameters constant. 

Finally you will see the number of [CCD Shift] will be updated by AutoCCD. 

You can do it again. Please don’t move the marked paper, and turn the laser power key off. 

Then press [Auto calibration] button again. It will do the above processes all over again. 

 

3.7.4.2 Position Test 

 This function is to use for finding star position and moving carriage. 

 

1.Go To: Set up the position to move 

2. Current Position: Show the present coordinate of the carriage. 

3. Go To Position: Move the carriage to the position which is setting in #1 

4. Go To Position 2: Move the carriage to the position 2 which calculates from #1 and 

two point setting. 

5. Homing: Move the carriage to home and reset the position of home if the carriage 

loses its position. 

6. Set as Start Point: After finding the start position, you can set the coordinate in #1 to 

be the start point by click this button. 
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7.Moving: You can moving

middle blank. 

 

3.7.5 Communication Setting
 Communication Setting is setup the communication port of RS232. Before change 

this setting, you need enter the password and click 

only change the port. If change other settings, the connection between PC and 

machine may not b

permission to change the setting.

Language Selection

you need enter the password and click 

Choose the COM port that connected PC and machine (

correctly). Make sure that the parameters in computer’s COM Port are the same as in 

AutoCCD. 
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moving the carriage toward four directions by the distance in the 

3.7.5 Communication Setting 
Communication Setting is setup the communication port of RS232. Before change 

this setting, you need enter the password and click [OK] to allow changing. Please 

only change the port. If change other settings, the connection between PC and 

machine may not be made. The [Disable] button can disable other one without 

permission to change the setting. 

Language Selection: User can change the language. Before change this setting, 

you need enter the password and click [OK] to allow changing.

COM port that connected PC and machine (the COM port should be 

). Make sure that the parameters in computer’s COM Port are the same as in 

by the distance in the    

Communication Setting is setup the communication port of RS232. Before change 

to allow changing. Please 

only change the port. If change other settings, the connection between PC and 

e made. The [Disable] button can disable other one without 

 

Before change this setting, 

to allow changing. 

the COM port should be identified 

). Make sure that the parameters in computer’s COM Port are the same as in 
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3.7.6 Tips of AutoCCD 
 The AutoCCD has a hot key function. When all parameters are setting. When the tap 

is on [CCD Task Control], you can press [Enter] to start the CCD task. When 

quantity production. You can connect a mini number keyboard. Setup parameters 

first. Then, you can just load/unload work-pieces and press [Enter]. 

Other Hot Keys 

Controls:  

Connect = Alt + C 

CCD Task Control: 

Browse = Alt + B 

Run = Enter 

CCD Setting: 

Go To Position = Alt + G 

Go To Position 2 = Alt + 2 

Homing = Alt + H 

Set as Start Point = Alt + S 

Up = Alt + U 

Down = Alt + D 

Left = Alt + L 

Right = Alt + R 

Ok = Alt + O 

Communication Setting: 

Ok = Alt + O 
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3.8  CCD Jobs Description 
 There are four types of jobs for user to use for SLC-M+ cutting with 

CCD. These jobs are special design for AutoCCD. Please note the 

version compatibility between jobs and AutoCCD.  

 

Job Function 

LTT_Pattern-1-200.job It works for single pattern. CCD will find the matched 

pattern in the field of view. It will output the defined 

position if the matched pattern is over the accept 

thresh. 

LTT_Pattern-2-200.job It works for both single pattern and two different 

patterns. 

LTT_Circle-1-200.job It works only for single circle pattern. 

Calibration_Circle_200.job It works for CCD calibration about FOV and CCD 

Shift. 

 

 

3.8.1 Single Pattern Job 
 AutoCCD use CCD to find reference marks in the material and calculate 

the position difference and rotate angle. If these reference marks are 

the same, then you can use this job. It works for single pattern. CCD 

will find the matched pattern in the field of view. It will output the 

defined position if the matched pattern is over the accept thresh. 

Job Name : LTT_Pattern-1-200.job  

 

Name Descriptions 

Model Region 

Press this button; you can train the pattern that you 

want.  

You can save the job setting as a <admin> user. For 

<operator> user, the job setting can not be saved. 

Ver. J2.00 This is the version of the job file. 
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Center 

Offset_Y 

You can fine tune the position of the trained pattern 

that you want CCD output. You can adjust it up and 

down. 

Tips:The green arrow aims the positive direction. 

Center 

Offset_X 

You can fine tune the position of the trained pattern 

that you want CCD output. You can adjust it left and 

right. 

Accept Thresh 
The minimum limit for the CCD find the matched 

pattern in the field of view. 

Score The score for the CCD find matched pattern. 

Exposure (ms) 

You can control the image acquire exposure time. The 

setting value is from 0.016 to 1000. When you use a 

lower exposure time, you have to input a higher LED 

light. 

Find region 

scale 

You can setup the find region area, the setting value 

from 10 to 99.5. 

 

3.8.2 Two Pattern Job 
 AutoCCD use CCD to find two marks in the material and calculate the 

position difference and rotate angle. If these two marks are not the 

same, then you can use this job. It works for two different patterns. 

This job can also work for the single pattern. 

Job Name : LTT_Pattern-2-200.job  

 

Name Descriptions 

ModelReg_

1 

ModelReg_

2 

Press this button, you can train the pattern 

that you want. 

You can save the job setting as a <admin> 

user. For <operator> user, the job setting can 

not be saved. 
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Center 

Offset_Y 

Center 

Offset_Y 

You can fine tune the position of the trained 

pattern that you want CCD output. You can 

adjust it up and down. 

Center 

Offset_X 

Center 

Offset_X 

You can fine tune the position of the trained 

pattern that you want CCD output. You can 

adjust it left and right. 

Accept 

Thresh_1 

Accept 

Thresh_2 

The minimum limit for the CCD find the 

matched pattern in the field of view. 

Score_1 Score_2 The score for the CCD find matched pattern. 

Exposure (ms) 

You can control the image acquire exposure 

time. The setting value is from 0.016 to 1000. 

When you use a lower exposure time, you 

have to input a higher LED light. 

Find region scale 
You can setup the find region area, the setting 

value from 10 to 99.5. 
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3.8.3 Circle Pattern Job 
 It works for single circle pattern. This job has two steps to find the 

circle center.  

1st step, it finds the pattern that matched. 

2nd step, it will find the circle in the matched pattern and output the 

center position. It will find the circle between inner radius and outer 

radius. 

Job Name : LTT_Circle-1-200.job  

 

Name Descriptions 

Model Region 

Press this button, you can train the circle pattern. 

You can save the job setting as a <admin> user. For 

<operator> user, the job setting can not be saved. 

Accept Thresh_M 
The minimum limit for the CCD find the matched 

pattern in the field of view. 

Score_M The score for the CCD find matched pattern. 

Inner Radius Inner radius setting. 

Outer Radius Outer radius setting. 

Accept Thresh_C 

The minimum limit for the CCD find the matched 

circle between inner radius and outer radius. You can 

adjust the level for different image. 

Find Circle Score 
The score for the CCD find matched circle between 

inner radius and outer radius. 

Exposure (ms) 

You can control the image acquire exposure time. 

The setting value is from 0.016 to 1000. When you 

use a lower exposure time, you have to input a 

higher LED light. 

Find region scale 
You can setup the find region area, the setting value 

from 10 to 99.5. 
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3.8.4 Calibration Job 
 It only works for CCD calibration about FOV and Shift. 

When you want to calibrate the <Pixel to MM> and <Auto 

Calibration>, you have to load this job. 

Run <Pixel to MM>, the AutoCCD will send a P2MM.prn file to machine. 

It will mark two circles at the center of the working area. AutoCCD will 

move the CCD to the position and find these two circle center and 

calculate the pixel to mm transform constant. 

Run <Auto Calibration>, the AutoCCD will send a shift.prn file to 

machine. It will mark one circle at the center of the working area. 

AutoCCD will move the CCD to the position and find the circle center 

and calculate the CCD shift constants. 

Job Name : Calibration_Circle_200.job  

 

Name Descriptions 

Model Region 

Press this button, you can train the pattern that you 

want. 

For the first time use this function, you have to train it 

and save. 

Accept Thresh 
The minimum limit for the CCD find the matched 

pattern in the field of view. 

Exposure (ms) 

You can control the image acquire exposure time. The 

setting value is from 0.016 to 1000. When you use a 

lower exposure time, you have to input a higher LED 

light. 

 Inner Radius Inner radius setting. 
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 Outer Radius Outer radius setting. 

 

Accept Thresh 

The minimum limit for the CCD find the matched circle 

between inner radius and outer radius. You can adjust 

the level for different image. 

 #1 Center 

Score 

The score for the CCD find matched circle between 

inner radius and outer radius. 

 #2 Center 

Score 

The score for the CCD find matched circle between 

inner radius and outer radius. 

 

3.8.5 Set the Default Job 
 When AutoCCD connects to the CCD, it will use the present job in In-sight explorer. 

If In-Sight Explorer does not be executed, AutoCCD will load the default job. 

This section will explain how to setup a job to be the default job. 

1. Connect to the CCD. 

Please make sure the job you want to set as a default job is in the CCD device. You 

can check it from the [In-Sight Files]. You can see display or hide it by pressing 

Shift + Ctrl + 2. 

3. Click [Sensor] -> [Startup…] 

 

4. Select the job you want to be set as the default job. Then, press [OK]. The setting 

will take effect after CCD restarted. 
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3.8.6 Job Copy, Save and Delete 
 If you need to do job copy, save and delete, you must use <admin> connect with 

CCD. For a <operator> user, it can not be done about save and delete actions. 

 

Copy Job from PC to CCD 

1.Copy the job at PC. 

2.Go to File / Open Job. Right click the mouse, choose Paste. 

 

 

 Copy, Delete, Rename a Job from CCD 

 1. Go to File / Open Job. Select a job and right click the mouse, choose Copy, Delete 

or Rename. 

 Right click mouse at PC’s folder, and choose Paste then you can copy the job to PC. 
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 Save Job 

 Go to File / Save Job As, it will open a Save As Window. 

You can choose a job to overwite or give a new file name to save. 
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Chapter 4  Maintenance 

4.1  Daily Cleaning 

 

1. Preparation 

Ensure that the system is turned off and the AC power cable is unplugged. 

Prepare for cotton swab, cotton cloth, and alcohol. 

2. Clean machine 

Remove all loose dirt and debris from inside of the machine. 

Clean the top window with cotton cloth and alcohol. 

Clean all of the rails of the motion system with cotton cloth and alcohol. 

3. Clean lens and mirror 

Clean the window lens with cotton swab and alcohol. 

 

Clean 3rd mirror with cotton swab and alcohol. 

 

Clean 4th mirror and focal lens with cotton swab and alcohol. 



Chapter 4   Maintenance 

 106 

Clean 4th  mirror with cotton swab and alcohol 

 

Lift the Z-axis to take out the lens, assembly it back after clean the lens. 
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4.2  Weekly Cleaning 

 

1. Preparation 

Ensure that the system is turned off and the AC power cable is unplugged. 

Prepare for compressive air which is waterless and oil free, dry brush, 

cotton swab and alcohol. 

2. Clean machine 

Clean all electric components with compressive air and dry brush. 

Clean exhaust port with brush. 

Clean all cooling fans with compressive air. 

Clean all filter cottons. 

3. Clean lens and mirror 

Clean 2nd mirror with cotton swab and alcohol. 

Remove the left alignment cover. 
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Remove the reflection mirror protection cover. 

 

 

Clean the mirrors, assembly back after clean. 
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Chapter 5  Trouble Shooting 

 This chapter provides suggestions to check and solve some common problem. If you 

can’t find any answer in this chapter, please see introduction to call technical 

support!! 

Problem Cause Remedy and reference 

Power is not turned 

on. 

AC power cable is not connected 

properly. 

Check Hardware Installation. 

(See section 2.4.) 

Emergency stop is pressed 

down. 

Turn right the pushbutton. 

(See section 2.3.) 

Laser beam is not 

emitted. 

Laser on/off switch may be 

turned off. 

Turn on the switch. 

(See section 2.3.) 

Doors with interlocks are not 

closed. (If “Door” indicator is 
dark.) 

Close all doors with interlocks. 

(See section 2.3.) 

The temperature of laser 

generator is too high. 

Stop job for a certain time to 

cool laser generator. 

Check the fans of laser and 

clean them. 

Laser beam is misalignment. Realign by adjusting mirrors. 

The setting of laser power is too 

low. 

Increase the setting. 

(See section 3.4.2.) 

Laser generator has 

breakdown. 

Please contact LTT. 

(See Introduction) 

Cutting or engraving 

quality is bad. 

Focal length is not suitable. Adjust focal length. 

(See section 3.3.1) 

Lens and mirrors are dirty. Clean the lens and mirrors. 

(See section 4.1 and 4.2) 

Setting of focal length on panel 

does not match with lens. 

Modify the setting. 

(See section 3.3.2) 

Lens and mirrors are broken. Please contact LTT. 

(See Introduction) 

The settings of laser power are 

not suitable. 

Modify the setting. 

(See section 3.4) 
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Appendices 

Appendix 1  Specifications 

 This section describes the specification of the SLC-M+ series. 

Model SLC-M+ 

Work area 630 (L) ×630 (W) mm 

Focal lens 

Movement 
50 (H) mm 

Max. speed 400 mm/sec (15.7"/sec) 

Resolution(DPI) 4064, 2032, 1354, 1016, 812, 677 

Memory Buffer 64MB 

Interface USB port 

Laser generator 30W /60W /100W 

(air-cooled CO2 laser) 

Power supply 220~240V AC, 30 Amp, 50/60 Hz 

Exhaust requiring at least 16.0 m³/min air flow for two 4" connection 

Regulatory 

Compliance 
RoHS directive 

Standard Auto Focusing 

Red-beam Pointer 

Beam Expender 

Honeycomb cutting table 

Options Blower 

Air compressor 
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Appendix 2  Dimensions 

 This section describes the dimensions of SLC-M+ series. 

SLC-M+ series 
Unit:mm 
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Appendix 3  Suggested Power and Speed Settings 

 The below settings are only intended to be starting points. Many variables can affect 

actual settings. Different manufacturers have different formulations, laser tubes differ 

in actual power output, natural materials vary greatly, and the user desired results will 

drastically affect actual settings. 

Laser Source : 30 Watt 

Material Type Thickness Speed Power PPI DPI 

Acrylic Engraving  100% 20%  500/1000

Cutting 3 mm 3% 100% 1000  

5 mm 2% 100% 1000  

10 mm 0.5% 100% 1000  

Anodized 

Aluminum 

Engraving  100% 40%  500/1000

Card Stock Cutting  40% 100% 250  

Cermark Engraving  25% 100%  500 

Ceramic Tile Engraving  60% 100%  500 

Coated Brass Engraving  100% 50%  1000 

Crystal Engraving  100% 30%  500 

Denim Engraving  100% 30%  500 

Cutting  20% 100% 500  

Glass Engraving  100% 50%  500 

Granite Engraving  60% 40%  333 

Laser Foil Cutting  50% 100%  1000 

Laserable Plastic Engraving  100% 20%  1000 

Cutting 1.5 mm 8% 100% 500  

Leather Engraving  100% 70%  500 

Cutting  2% 100%   

Marble Engraving  60% 23%  333 

Rubber Stamp Engraving  15% 100%  1000 

Cutting  4% 100% 500  

Wood Engraving  100% 100%  500/1000

Cutting 3 mm 7% 100% 500  

6 mm 2.5% 100% 500  

 

 

 


